SESSION HANDOUT
Excel Pivot Tables

Excel Pivot Tables: Design a Pivot
Table & Get the Report You Want

SESSION HANDOUT

A APPLIED

Client Network

Applied Client Network

www.appliedclientnetwork.org



SESSION HANDOUT A APPLIED

Excel Pivot Tables Client Network

Prepared for Applied Client Network

Applied Client Network
2340 S. River Road, Suite 311
Des Plaines, IL 60018
Phone: 220-220-1444 Fax: 224-220-1443

Copyright © 2014 by Applied Client Network, Inc., 2340 S. River Road, Suite 311, Des Plaines, IL 60018. Protection claimed in all
forms and matters of copyrightable material and information now allowed by law or hereafter granted including both electronic and
conventional distribution of herein products. Reproduction or transmission unless authorized by Applied Client Network is prohibited.
All rights reserved. Specific product information regarding Applied Systems’ The Agency Manager and Vision, as well as other
products copyrighted and mentioned within (ex: Microsoft, Excel, etc.) are the product of the individual company and no endorsement
or ownership of product should be implied by its mention and use. All workflows are suggested and common workflows. Users of
this material agree that Applied Client Network cannot be held liable for any omissions or errors within the guide.

Original Author:
Name Where From
Sue Good Alexant Systems Corporation

Updated By:

Name Where From Date Done
Sue Good Alexant Systems Corporation September 2014

Target Audience:

X | Accounting Account Executive
Non-Insurance Accounting X | Customer Service Representative
Administrative New Producer

X | Principal Experienced Producer

X | General X |IT
Human Resources X | Other: Operations, Trainer

Seminar Type: Microsoft Products, Reports

Seminar Level: Intermediate Level: An Intermediate level class takes the concepts originated
from a basic level course, and adds more layers or parallel concepts. For functional courses,
these classes will require the participant or attendee to have some basis to work from as they are
learning new facets of the agency management system or software program

Class Description: Discover the Power of the Pivot! Summarize and Analyze your data quickly
and easily, and have fun while you’re at it . These skills will save you hours of time you would
normally use formatting and calculating. Automatically sort, sum, count, and layout the
information you want to see. Don't just watch, do it yourself! Follow along with the Excel
workbook provided to practice the skills demonstrated.

Learning Outcomes:
e Format the Excel data for a Pivot Table
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e Take data from your Management Systems into Excel and manipulate it into
meaningful information.

e See how easy it is to Drag and Drop data into Columns, Rows, Values and Filters
to build tables and reflect different views of the same data that will make you a
report rock star in your agency.

Assumptions: This seminar is based on the following
This seminar is based on the following

TAM Version 2014

Microsoft ® Word Version 2010
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Overview
Using a pivot table is the quickest way to summarize and compare data.

So instead of running multiple iterations of the same report from my management
system, | just run a single report exported to Excel, and use the power of pivot tables to
analyze the data in multiple ways.

Setup the data in Excel
Here are a few rules to follow when setting up your data so pivot tables play nicely:

e You need to have your data organized in columns with headings. These headings
will be used when you create the pivot table. Excel will display an error if a
heading is missing on a column with data.

e Make sure there are no empty columns or rows in your data. Empty cells are OK,
but not empty rows or columns.

e Consistent data in all cells. If you have a date column, make sure all the values in
that column are dates (or blank). If you have a quantity column, make sure all the
values are numbers (or blank) and not words.

Create a Pivot Table
To create a Pivot Table, click on any cell in the worksheet.

On the Insert tab, Tables group, click the Pivot Table button.

m Haome Insert

=1 E=lEE

PivotTable Table Ficture
- J

Just click OK to accept the defaults. Excel will insert a new worksheet with the layout
area and the Pivot Table Field List.
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To build a report, choose
fields from the PivotTable
Field List

PivotTable Field List - X

Choose fields to add to report: ‘_-L'_a i

[pol_polidx
[Cclient Code
[JPol_agey
[CIPol_brch
[(]Pol_dept
[CEffective
OmMe

[I¥ear

Drag fields between areas below:
W Report Filter 7 Column Labels

14 RowlLabels % Values

[] Defer Layout Update Update

~
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If you get an error that the PivotTable field name is not valid, it’s because there is a
column in your original spreadsheet that does not have a header. Since the Headers
appear in the Pivot Table field list, you MUST have a header for each column.

The Pivot Table Field List contains ALL the columns from the source data worksheet.

There are several ways to move fields to the areas of the pivot table:

1. Right Click on the field name, and select the desired area.
2. Drag and Drop the variables of your choice to the Row, Column, Value and Filter
boxes. You can easily move these variables from one box to another. Just drag

and drop and watch your Pivot Table change.

3. Check the box next to the Field Name. Excel will decide where to put the data
(Drag and Drop to another box if you don’t like where Excel put it).

NOTE: If the Pivot Table Field List disappears, just click on any cell in the Pivot Table,
and the Field List will appear again.

Example: Insert a Pivot Table from the worksheet named “BOB12-13-2012”. List the

Commission Amounts sorted by Policy Type.

Change Field Settings
e Right click on a data item in your pivot table and select Value Field Settings

Applied Client Network | www.appliedclientnetwork.com
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Value Field Settings ? n

Source Name: Co_amt

Custom Mame: |Commission .ﬁ.mauntl

summarize Values By | Show Values As

Summarize value field by

Choose the type of calculation that you want to use to summarize

~
Count

Average

Max

Min

Product A

[ Mumber Format Cancel

e Select from options such as Sum, Average, Count, etc.
e Click Number Format and choose the format for your output.

A
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e In the Custom Name field retype the heading so it is of more value to those who

receive your report.

Example: | also want to see the number of policies per policy type. Drag and drop the
co_amt field from the list to the Value Box. Right click on a number in the new
column, and select “Value Field Settings”, and change from “Sum” to “Count”.

Sort Data in Pivot Table

e Click on any cell in the column of the Pivot Table to sort

e On the Pivot Table Tools tab, in the Sort Group, Select A-Z or Z-A, and the Pivot

Table will be sorted accordingly.

See the Detail for a Data Value

e Double Click on any data value in the Pivot Table, and Excel will open a new
worksheet in the existing workbook with a table containing all the rows of detail

that total the number in the Pivot Table.

e If you no longer need the detail sheet, just right click on the sheet name, and Click

Delete.

Applied Client Network | www.appliedclientnetwork.com
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Example: Let’s add columns for each department by dragging and dropping the
Department Code (Pol_dept) field to the Column Labels.

Example: Now, let’s add a Filter for the Billing Company E50. Drag and Drop Billing

Company (Bco) to the Report Filter. Click the dropdown arrow next to the word ALL,
and select company E50.

Example: Now, let’s add another piece of data to our table. Let’s bring the Producer
into the row above the policy type. Drag and drop the Pr1 field into the “Row Label”
box. Notice the Producer code is below the Policy Type. Just Drag and Drop the Pr1
field above the Pol_type field. Now the pivot table is sorted by Producer, by Policy
Type.

Place subtotals at bottom of Categories

Example: I'd like to see my totals below the category, not above it. To change how
the table is subtotaling:

Make sure your cursor is clicked somewhere in the Pivot Table.

Pive

Options

e Tonls

Design

e Click on the Design tab on the PivotTable Tools ribbon. |4 B RS
e On the left-hand side of the ribbon, click on the Subtotals button.
e Click on Show all Subtotals at Bottom of Group.

V| Row Hea

ubtotals] Grand Report Elank

¥ Column b
~ Totals = | Layout = Rows =

Do Mot Show Subtotals

Show all Subtotals at Bottom of Group

Show all Subtotals at Top of Group
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Group Data (ie, group dates by month/year)

¢ Right click on a date in the pivot table.
e Select Group
¢ In the Grouping dialog box, select Month and Year, or just Year

Example: Insert a Pivot Table from the worksheet named “Prod Data 2011-2012”. List
the Commission Amounts sorted by Producer, by Year

Copy and Paste Data only to a new sheet

e Click in the first cell in the Pivot Table
e Citrl-A on your keyboard (this will select the active cells)
e Click Copy

Home

Clipboard

e Click in the new worksheet.
¢ Click Paste-Paste Values

Pastgq Values

O

[155 1 12}

er Paste Options

Paste Special...

This will paste only the data, not the pivot table to the new worksheet.
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Slicers

In earlier versions of Microsoft Excel, you can use report filters to filter data in a
PivotTable report, but it is not easy to see the current filtering state when you filter on
multiple items. In Microsoft Excel 2010, you have the option to use slicers to filter the
data. Slicers provide buttons that you can click to filter PivotTable data. In addition to
quick filtering, slicers also indicate the current filtering state, which makes it easy to

understand what exactly is shown in a filtered PivotTable report.

A slicer typically displays the following elements:

1 A slicer header indicates the category of the items in the slicer.

| salesperson 1 .= 4
| 2 A filtering button that is not selected indicates that the item is not included in the

Buchanan . filter.

Callshan
2 3 A filtering button that is selected indicates that the item is included in the filter.

Davolio
Dodswaorth . 5 4 A Clear Filter button removes the filter by selecting all items in the slicer.
Fuller 3
5 A scroll bar enables scrolling when there are more items than are currently

king visible in the slicer.
Leverling

6 5 Border moving and resizing controls allow you to change the size and location
Peacock of the slicer.

Create a Slicer
1. Click anywhere in the PivotTable report for which you want to create a slicer.

This displays the PivotTable Tools, adding an Options and a Design tab.

2. On the Options tab, in the Sort & Filter group, click Insert Slicer.

Insert
Slicer =

Sort & Filber

Excel Pivot Tables // PAGE 9
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3. Inthe Insert Slicers dialog box, select the check box of the PivotTable fields for
which you want to create a slicer.

4. Click OK. A slicer is displayed for every field that you selected.
5. In each slicer, click the items on which you want to filter.

6. To select more than one item, hold down CTRL, and then click the items on which
you want to filter.

Delete a Slicer

e Click the slicer, and then press DELETE.

Excel Pivot Tables // PAGE 10
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APPENDIX |

Sample Search-Customers, Policies Current Criteria/Fields

File Options Wizards Help

X
LT e Report Selection | Criteria ( 4 I|, Description Fisldsisort ( B I

Run
= Report Type Report Choices
EE h - Customers Form - Medical Benefit
Reports Search - Prospects Form - Personal Auto
Search - Files Form - Personal Motepad
L1 Search - General Ledger Form - Personal Umbrella
arch Search - Miscellaneaus Farm - Primary Census
EI =| |Form-Property Loss Notice
Form - Short Term Disability
ES Form - Statement of Values
ﬁ% Output Destination Form - Transportation
Tererm] Faorm - Truckers
™ Data Preview " Report Farm - Vision Benefit
&j’ " Mail Labels " Text File :::0”“ —:.Eatigraﬂ Lose Nat
) orm - WorkComp Loss Motice
Month-End 9 8
Word Mailmerge CQueue Report Farm - Workers Cam
B 6) Comne  EOFEGTEIN 3 EE—
Queue © Excel - EIS Automat Palicies - History
" Excel - Consolidated File Palicies - With This and This
III'. ™ Save as User-Defined F'ol?cies - Withl Thisl, Not That
Dashboard " Save as MonthEnd Report Palicies —lwah|s,Th|s,N0tThat
= . Transactions - Customers
ﬂ Saveas Cusiom Report Transactions - Pending -
Exit

1. Click Reports — Search

2. Report Type: Search — Customers
3. Report Choices: Policies — Current
4. Criteria Tab

Customers All Custamers ;l

Range of Customers All

Customer Codes All Gustomer Codes

Customer Senice Reps Al CERs

Billing Companies All Billing Companies

lssuing Companies All Issuing Companies

Master Companies All Master Caompanies

Producer All Producers

Broker All Brokers

Policy Type All Policy Types

FPalicy Type Graup All Palicy Type Groups

Policy Status Selected Policy Statuses ——* Select Active Policy Statuses
Bill Made AllBill Modes

Date FirstWiitten All Dates

Effective Date All Dates

Expiration Date 120112008 - 1 2312015 memmm———rgp. Se/eCt Range of dares that does
Lines of Business All Lines NOT include expired policies
Broker Comm % All ltems

B At of Broker Comm e e Found Will list ALL billing screens,

Mo including subsections

a. Policy Status — Only ACTIVE policy statuses (NEW, REN, REI, REW —
whichever codes YOUR agency uses)

Excel Pivot Tables // PAGE 11
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b. Expiration Date — You might want to limit the Expiration Date range to include
only billing screens that are expiring after the month you are closing. For
example, if you are running the report at November 30, 2009, choose an
Expiration Date range of 12/01/09 thru 11/30/2015. This will keep all the old
billing screens with inaccurate policy statuses from skewing the report, but
include all expiration dates in the next six years.

c. Record Listings — Choose “List Each Time Found”, and then manipulate in
Excel to get only the commission and premium on the main package or on the
subsections.

5. FIELDS/SORT (Include as many as desired, but be consistent each month)

Field Name Excel Column Title
Customer/Pol_idx Number Pol_polidx
Agency Pol_agcy
Branch Pol_brch
Department Pol_dept
Policy Number Pol

Policy Effective Date Effective
Policy Expiration Date Expires
Date First Written Fwritten
Policy Type Pol_type
Policy Type Group Typegroup
Issuing Company Ico

Billing Company Bco

Type of Agency Commission Co_type
Total Commission Amount Co_amt
Total Commission % Com_p
Billing Mode Bill
Producer One Pr1
Producer One Comm % Pr_p
Producer One Comm $ Pr_amt1
Producer Two Pr2
Producer Two Comm % Pr_p2
Producer Two Comm $ Pr_amt2
Producer Three Pr3
Producer Three Comm % Pr_p3
Producer Three Comm $ Pr_amt3
Policy Premium Prem
Policy Status Pol_status
Policy Customer Service Rep Pol_csr
Customer Number Cust_rec
Customer Name Cust_name

Applied Client Network | www.appliedclientnetwork.com

Excel Pivot Tables // PAGE 12



SESSION HANDOUT A APPLIED

Excel Pivot Tables Client Network

6. Back to Report Selection Tab:
a. Output Destination — Excel-Raw Data

123 TAM Reports

7. Click Run.
OMDOCSP - SHEETV.KLSX —
8. = % Always choose the 3rd radio button to “Send output to a

temporary file”. Click OK
rewrie k|

:) 0AS_TEMPIS9S25515.5L5% - Mew Fils,
-

Ok to create new fils?

. _N4I Click “Yes” to create a new temporary file.

\:.’,) Copy complete! Load Excel now?

es Mo |

. Click “Yes” to Load Excel. Excel will open with your Billing
Screen data.
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